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SUMMARY

Here, we provide a protocol to automate the quantification of the number of
phospho-histone H3-positive cells in the developing nervous system of zebrafish
using a custom MATLAB script to identify labeled nuclei. We describe steps for
fixation, immunolabeling, and imaging of zebrafish embryos. We then detail
the analysis steps using Fiji and MATLAB. This protocol can be used for fixed,
immunolabeled tissue, as shown here, or for live samples, such as cells expressing
a histone-GFP fusion protein.
For complete details on the use and execution of this protocol, please refer to
Biswas et al.1
BEFORE YOU BEGIN

1. Download and install FIJI (Image J version 2.9.0). Follow the instructions for your operating sys-

tem on https://imagej.net/software/fiji/downloads.2

2. Download and install MATLAB (current version R2023a) https://www.mathworks.com/products/

matlab.html.

3. Download the NoRMCorre package (https://github.com/flatironinstitute/NoRMCorre) and place

in the MATLAB search path. This package contains the utility for opening TIFF files.

4. Construct an imaging chamber by using Sugru or Sylgard to build walls on a standard 3 3 100 mi-

croscope slide. This will be used to image immunolabeled zebrafish embryos on an upright

confocal or 2-photon microscope fitted with a water immersion objective.

5. Prepare an embryo orienting tool by breaking off the handle of a long cotton swab.

a. Split the end by pushing a razor blade into one of the ends of the wooden handle by about

1/8th inch.

b. Place a droplet of Crazy Glue or similar adhesive onto the split end.

c. Push a 3/4 inch piece of monofilament fishing line into the split created by the razor.

d. Add more adhesive if needed and let cure.

Note: The filament can then be used to gently maneuver embryos within agarose droplets for

proper orientation before imaging.
Institutional permissions

The zebrafish is a vertebrate species. Research using zebrafish requires permission from an institu-

tional animal care and use committee (IACUC) or its equivalent. All animal procedures were per-

formed in accordance with the Ohio State University animal care committee’s regulations.
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KEY RESOURCES TABLE
REAGENT or RESOURCE SOURCE IDENTIFIER

Antibodies

Phospho-histone H3 (Ser10) antibody
(1:200 dilution)

Cell Signaling Technology Cat# 9701; RRID: AB_331535

Alexa Fluor 594 goat anti-rabbit IgG
(H + L) (1:500 dilution)

Molecular Probes Cat# A-11005; RRID: AB_141372

Chemicals, peptides, and recombinant proteins

16% Paraformaldehyde Electron Microscopy Sciences Cat# 15710

Acetone Sigma-Aldrich Cat# A4206

PBS Sigma-Aldrich Cat# P3813-10PAK

Tween 20 Sigma-Aldrich Cat# P7949

Low melting point agarose II VWR Cat# 0815-25G

Blocking reagent Roche Diagnostics Cat# 11096176001

Fetal bovine serum Gibco Cat# 16140-071

Experimental models: Organisms/strains

Zebrafish: WT/TL Zebrafish International
Resource Center (ZIRC)

ZDB-GENO-990623-2

Software and algorithms

Fiji http://fiji.sc RRID: SCR_002285

MATLAB https://www.mathworks.com/ RRID: SCR_001622
MATERIALS AND EQUIPMENT
60X E3 Embryo Medium

Reagent Final concentration Amount

NaCl 300 mM 17.2 g

KCl 10 mM 0.76 g

CaCl2-2H2O 20 mM 2.9 g

MgSO4-7H2O 20 mM 4.9 g
Note: Add water to 1 L and stir until dissolved. Store 60X stock solution in fridge. To make 1X

solution, dilute 16.66mL of 60X stock solution in dH2O to a total of 1 L. Store 1X solution under

non-sterile conditions at 22�C–25�C for 12 months (Westerfield, 1995).3

dH2O N/A Add to 1 L
23 PBS

Dissolve two packets of Sigma #P3813-10PAK in 900 mL dH2O with slow stirring. Add additional

dH2O to a total of 1 L. Store at 4�C for 12 months.
4% Paraformaldehyde

Reagent Final concentration Amount

16% paraformaldehyde 4% 10 mL

23 PBS 13 20 mL

dH2O N/A 10 mL

Open glass ampule of 16% paraformaldehyde and transfer 10 mL to 50 mL conical tube. Add 20 mL 23 PBS and 10 mL dH2O.

Store for up to 1 month at 4�C.

2

CRITICAL: Use personal protective equipment (PPE), including gloves and surgical mask.
Work under a fume hood if possible.
STAR Protocols 4, 102596, December 15, 2023
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20% Tween 20

Add 20 mL Tween 20 to 80 mL dH2O and stir with magnet on stir plate until well dissolved. Store at

22�C–25�C indefinitely.
13 PBST

Add 0.5 mL 20% Tween 20 to 100 mL 1X PBS for a final concentration of 0.1% to 1X PBS. Store at

22�C–25�C for up to 1 month.
Blocking Buffer

Reagent Final concentration Amount

Roche Blocking Powder 2% 1 g

23 PBS 13 25 mL

dH2O N/A 24.25 mL

20% Tween 20 0.1% 0.25 mL

DMSO 1% 0.5 mL

Fetal bovine serum 10% Add before use

Dissolve 1 g Roche Blocking Powder in 25mL 23 PBS and 15mL dH2O using vortex and heating (incubate in glass beaker with

60�C–65�C water to help dissolve powder, vortexing every few minutes to help dissolve powder; it is not likely all will go into

solution). Add 9.25 mL dH2O, 0.25 mL 20% Tween 20, 0.5 mL DMSO. Store at 4�C for up to 1 month. Powder that does not go

into solution will settle; pipette off of the top when using and avoid pipetting solids. Add 10% fetal calf serum just prior to use.
2% low melting point agarose

Add 0.5 g low melting point agarose to 25 mL 1X PBS in 50 mL conical tube. Place conical tube

in glass beaker with enough water to cover agarose solution. Microwave in 20 second intervals to

slowly dissolve agarose until completely liquified. Equilibrate in a 40�C water bath for 1 h prior to

use. Store in 40�C water bath for up to 1 week.
STEP-BY-STEP METHOD DETAILS

Fixation of zebrafish embryos

Timing: 1–2 days

The first step in this protocol is to collect zebrafish embryos at the desired time points and

fix them in paraformaldehyde for further processing. The following steps were performed on

embryos at 18 h post fertilization (hpf), but the steps can be adapted for other developmental

time points.

1. Set up adult zebrafish mating the day before you want to collect fertilized eggs. Collect embryos

from mating pairs and maintain in E3 media at 28.5�C (Westerfield, 1995).3

2. Prior to fixation, dechorionate embryos using a fine pair of tweezers. Transfer 25 embryos at

18 hpf for each sample into 1.5 mL centrifuge tubes.

Note: Sex characteristics are not distinguishable at early stages, but both sexes are typically

represented in a clutch of embryos.

3. Add 1 mL of 4% PFA per tube and fix samples for 1–2 h at 22�C–25�C while gently rocking on

rocker plate.

4. Remove PFA and rinse embryos 33 5min in 1X PBS. Rinse for 4–24 h in 1X PBS at 4�Cwhile laying

tube on its side, or on rocker plate, to further clean the embryos.

Note: Fixation for longer periods can lead to higher background. Use fresh fixative (less than

1 month old).
STAR Protocols 4, 102596, December 15, 2023 3
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CRITICAL: Use personal protective equipment (PPE), including gloves and surgical mask.
Work under a fume hood if possible. PFA is toxic and liquid waste should be collected and

discarded according to specific handling protocols.
Permeabilization and immunostaining

Timing: 2 days

Embryos are permeabilized in cold acetone and incubated at -20�C to prepare them for blocking

and antibody incubations. Embryos are then rinsed and blocked prior to incubations with primary

and secondary antibodies.

5. Prechill a small amount of acetone at -20�C, enough for permeabilizing all samples.

6. Remove PBS from tubes and add 1 mL prechilled acetone.

7. Incubate tubes on their sides at -20�C for 7 min.

Note: For older embryos (48–72 hpf), 8–10 minutes can be used, but timing should be opti-

mized for each age.

8. Quickly remove acetone and wash embryos once quickly in water at 22�C–25�C, dropping the last

few drops on top to push floating embryos back down into the tube.

CRITICAL: Use personal protective equipment (PPE), including gloves and surgical
mask. Acetone waste should be collected and discarded according to specific handling

protocols.
9. Remove water and rinse embryos 2 3 5 min washes in PBST at 22�C–25�C while gently rocking

on rocker plate.

10. Replace wash solution with 500 mL Blocking Buffer and incubate embryos for at least 1 h at 22�C–
25�C on rocker plate.

11. Incubate embryos in anti-phospho-histone H3 primary antibody (diluted 1:200) in Blocking

Buffer (200 mL per tube) for 12–24 h at 4�C on rocker plate.

Note: To ensure embryos stay submerged, you can prop the tubes up on their hinges.

12. The next day, rinse embryos 4 3 5 min in PBST at 22�C–25�C on rocker plate.

13. Incubate embryos in secondary antibody (diluted 1:500) in Blocking Buffer (500 mL per tube) for

4 h at 22�C–25�C or for 12–24 h at 4�C on rocker plate.

Note: Embryos should be protected from light during and after they are immunolabeled with

the secondary antibody to prevent photobleaching.

14. Rinse embryos for several hours in 5 changes of PBST at 22�C–25�C while gently rocking on

rocker plate.

Note: Embryos can be kept in PBS for 12–24 hours at 4�C before imaging without loss of

signal.
Mounting embryos in agarose and collecting image stacks

Timing: 1+ days
STAR Protocols 4, 102596, December 15, 2023
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Embryos are mounted in a row using 2% low melting point agarose in the same orientation to cap-

ture regions of interest. The imaging tray is then placed on a confocal or 2-photon microscope and

image stacks are collected at 1 mm intervals to capture all the immunolabeled nuclei. Parameters can

be changed to collect images from other regions of interest.

15. Equilibrate a 50 mL conical tube containing 25 mL of 2% low melting point agarose in 1x PBS at

40�C before mounting embryos.

16. Select well labeled embryos under fluorescence and place in a small depression slide or similar

shallow holding container.

17. Moving quickly, select an embryo from the holding container using a glass Pasteur pipette

and quickly drop it into the warm agarose with as little buffer as possible. Remove residual

buffer from transfer pipette. Immediately draw up the embryo with the glass pipette and

transfer the embryo in a small droplet of liquid agarose onto the glass imaging chamber bottom

(Figure 1A).

18. Quickly orient the embryo within the agarose droplet so that the region of interest is facing

upward, which is the direction from which the microscope objective will be imaging.

19. Collect image stacks of your region of interest.
Image processing using Fiji/ImageJ

Timing: 1+ days

Image stacks are processed using Fiji/Image J to enhance brightness and contrast and to mask areas

that are not included in the analysis (see Methods video S1).

20. Open an image stack in Fiji/ImageJ by selecting ‘‘Open’’ under the File dropdown menu and

then selecting the .tif file name of your image stack.

21. In the ‘‘Bio-Formats Import Options’’ window, select ‘‘Hyperstack’’ in the ‘‘View stack with’’ drop-

down menu at the top and select ‘‘Autoscale’’ at the bottom left. Click ‘‘OK’’ at the bottom.

22. Adjust Brightness/Contrast of your images by selecting the ‘‘Image’’ dropdown menu and then

the ‘‘Adjust’’ and ‘‘Brightness/Contrast’’ options. When you have adjusted the brightness and

contrast of the nuclei in your image stack, click ‘‘Apply’’ to retain the settings.

23. To remove noise from your image stack, select the ‘‘Process’’ dropdownmenu and then ‘‘Filters’’

and ‘‘3D Gaussian Blur’’. This will blur the pixelated noise within your image. Select a radius that

reduces the noise without blurring the image too much. For our images, we used a radius of 1.5

for X, Y and Z sigma. Click ‘‘OK’’ to apply the filter.

24. Make a Z projection of your image stack by selecting the ‘‘Image’’ dropdown menu and then

selecting ‘‘Stack’’ and then ‘‘Z Project’’. Select ‘‘Max Intensity’’ to make the Z Projection image

(Figure 1B). Click ‘‘OK’’ to continue.
Figure 1. Steps to isolating a well labeled nucleus to use as a template

(A) Shown here is a region of a single optical section from an image stack. An isolated nucleus is shown in the yellow box.

(B) The boxed region in A was cropped to a 32 3 32 3 32 volume with the nucleus centered within the volume and no other fluorescent objects present

within the volume.

(C) The template was processed by applying a Gaussian Blur (radius = 1.5) and adjusting brightness and contrast.

STAR Protocols 4, 102596, December 15, 2023 5
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25. Select the Freehand selection from the ImageJ toolbar. Using a continuous line, encircle the

area of interest (Figure 1C).

26. Click on the original window of the image stack and then the ‘‘Edit’’ dropdown menu. Click

on the ‘‘Selection’’ option and then select ‘‘Restore selection’’. This should transfer the encircled

region of interest from the Z projection to the image stack.

27. Click on the ‘‘Edit’’ dropdownmenu again and select ‘‘Clear Outside’’. This will delete the image

outside of your encircled region of interest.

28. Save your new image stack as a new file name by clicking on the ‘‘File’’ dropdownmenu, clicking

on ‘‘Save As’’, and then selecting the ‘‘Tiff.’’ format. Create a new folder and rename all of your

new masked files.

29. To generate a template for cross-correlation, identify an isolated, well-labeled nucleus. Crop

the nucleus in 3D, such that no other nuclei or fluorescent debris are present within the vol-

ume. The presence of extraneous fluorescence within the template will introduce noise into

the correlation map. To generate a template nucleus, center the nucleus within a square

bounding box, then select the "Image" dropdown menu and then "Crop’’ (Figure 2A) Then

select the "Image/Stack/Tools/Make Substack" command in the Fiji dropdown menu. Select

the sections containing the nucleus, leaving at least 2 blank sections above and below the

selected nucleus. The nucleus should be centered in XYZ within the volume (Figure 2B). To

remove noise, select the "Process" dropdown menu and then, "Filters" and "3D Gaussian

Blur’’ (Figure 2C). Select a radius that reduces the noise without blurring the image too

much. For our images, we used a radius of 1.5 for X, Y and Z sigma. Click ‘‘OK’’ to apply

the filter.
Figure 2. Running the MATLAB script

The script may be run either by clicking the "Run" arrow (red box) or by typing Auto_Count into the Command Window. The only parameters that need

to be modified are the filenames and the threshold value (highlighted in yellow) in the Editor Window. Once finished, the number of detected cells will

be stored in the "Count" variable (highlighted in red), which can be found in the Workspace (right-hand side of screen).

6 STAR Protocols 4, 102596, December 15, 2023
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Quantification of labeled nuclei using MATLAB

Timing: 1+ days

Processed image stacks are analyzed using a custom script written in MATLAB (see Methods

video S1).

30. Open MATLAB. Navigate to the folder containing your image stacks and cropped template.

Open the Auto_Count.m script in the Editor window. Prior to running the script, parameters

such as "threshold" and the filenames of the template and image stack can be edited.

31. Make sure that the Auto_Count.m script is in your MATLAB search path or that it is in the active

folder.
TemplateName=’template.tif’; % an image stack containing a well-shaped, isolated nucleus,

cropped to powers of 2, 16x16x16, for example.

FileName =’image_0001.tif’; %the base name (without the sequential numbers) of image stacks

with nuclei to be counted

threshold=0.02; % the threshold to filter peaks in imhmax. Optimize for your own data.

% Higher values--> fewer cells

% Lower values--> more cells

% Depends on image noise and pre-processing,

% as well as cell density

%to avoid boundary effect in the FFT, both the template and image need to

%be padded to the nearest power of 2: a 512x512x128 stack should be padded to 1024x1024x256

%the FFT runs more efficiently if the dimensions are powers of 2 (128, 256, 512, 1024, ...)

%this is accomplished in the template by defining the S array for the fftn

%function

%this is accomplished for the image stack using padarray function

%both H (the transform of the template) and F (the transform of the stack)

%must have the same dimensions.

template = read_file(TemplateName); %reads in multiplane TIFF file (or some other file formats)

S=[1024,1024,256]; %assumes a padded stack size of 1024,1024,256

H=conj(fftn(single(template),S));

%cross-correlation, then read the cell numbers into the row vector "Count"

stack=padarray(read_file(FileName),[256 256 64]); %pads 512x512x128--> 1024x1024x256

% by adding 128 pixels to each edge and 64 slices to top and bottom of

stack

[Center, avg_img, Cell_N] = CC3D(H,stack,threshold); %pass the fft’d template,

% the padded image stack and the filter threshold to a function

Count = Cell_N;

figure, imagesc(max(avg_img,[],3));

hold on scatter(Center(:,1,:),Center(:,2,:),’m*’);

figure, scatter3(Center(:,1,:),Center(:,2,:),Center(:,3,:),’m*’);

STAR Protocols 4, 102596, December 15, 2023 7



%function to do the 3D cross-correlation and gives the number of correlation peaks above the

threshold

function [Center, corm_sing, Cell_N] = CC3D(H,stack,threshold)

F=fftn(single(stack));

corrm=real(ifftn(H.*F));

corm_sing=single(mat2gray(corrm));

corrmap1=imhmax(corm_sing,threshold);

corrmap2=imregionalmax(corrmap1);

masks=bwlabeln(corrmap2);

objects=regionprops(masks,’centroid’);

Center=cat(1,objects.Centroid);

Cell_N=length(Center);
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32. In the Editor window, assign the name of your cropped template to the variable, TemplateName,

in the Auto_Count script. For example, TemplateName= ’template.tif’; Assign the name of the file

to. Be analyzed to the variable, FileName. For example, ’image_0000’ or ’wild_type’: FileName =

’wild_type.tif’; or FileName = ’image_0001.tif’;

33. Run the script by typing Auto_Count at the MATLAB command line or by clicking the "Run"

button in the Editor tab toolbar. The number of cells detected is governed by the threshold

parameter. Increasing the threshold increases the stringency of the peak detection (reduces

the number of identified cells). The threshold will need to be adjusted to each new dataset

and use (Figure 3).

34. The number of cells detected in each stack will be stored in the variable, Count, which

will appear in the Workspace window on the right-hand side of the MATLAB environment

(Figure 3).

end
EXPECTED OUTCOMES

With this approach, users should generate a total count of fluorescently labeled objects in a 3D

image stack, as well as the objects’ x, y, z coordinates. These represent the positions of each object

that closely matches the shape and intensity profile of the template.
LIMITATIONS

Our protocol detects high contrast, circular or ovoid objects in 3D image stacks. Noisy images or

weakly-labeled objects will degrade the performance of this approach and would require careful

tuning of the threshold applied to the correlation map in order to exclude background peaks.

While this correlation-based approach could, in principle, be used to identify instances of more

complex objects, this straight-forward implementation is best suited for objects with approximate

spherical symmetry. In addition, for best performance, objects should be clearly separated to yield

clear peaks in the correlation maps. For example, densely labeled samples, such as DAPI-stained

samples, could pose a challenge to this approach. In addition, tuning of the threshold parameter

will also influence how cross-correlation deals with mitotic profiles. Phospho-Histone H3 will label

condensed chromosomes in metaphase or anaphase, for example. These profiles will generate

correlation peaks, but will be weaker than for fully ovoid nuclei. A lower threshold would correctly

count anaphase or telophase chromatin as two cells, while a higher threshold may exclude these

objects.
8 STAR Protocols 4, 102596, December 15, 2023



Figure 3. Imaging chamber, steps of image processing and final 3D graph showing nuclei counted within region of

interest

(A) Shown here is one example of an imaging chamber, made using Sugru to create walls to hold buffer on a standard

3 inch by 1 inch slide. The embryo orienting tool was made using monofilament fishing line and the handle of a long

cotton swab.

(B) A maximum intensity projection of a 128 image stack of phospho-histone H3-immunopositive cells in an 18 hpf

embryo was made using Fiji/ImageJ image processing program. Scale bar, 50 mm.

(C) The freehand selection tool was used to select the nuclei located within the neural tube and to exclude labeled

cells on the surface of the yolk. The selection was applied to the image stack and the ‘‘Clear Outside’’ function was

selected to remove the surrounding nuclei. Scale bar, 50 mm.

(D) Running the MATLAB Script ‘‘Auto_count.m’’ on the processed image stack yields a total count of labeled nuclei

found only within the neural tube throughout the 128 images. Scale bar, 50 mm.
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TROUBLESHOOTING

Problem 1

The fluorescent signal is weak, making the nuclei hard to detect.
Potential solution

� Make sure 4% paraformaldehyde is not too old. We routinely use fixative for up to one month, but

if problems persist, make fresh paraformaldehyde solution for fixation (see Step 3 in fixation of ze-

brafish embryos section).

� Don’t let embryos sit in PBST solution too long after rinsing out secondary antibody. If embryos

will be imaged the following day, place in PBS instead of PBST for 12–24 h (see step 14 in perme-

abilization and immunostaining section).

� Primary anti-phospho-histone H3 antibody can lose efficacy over time, so a new aliquot of antibody

might solve the problemof weak signal (see step 11 in permeabilization and immunostaining section).
STAR Protocols 4, 102596, December 15, 2023 9
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Problem 2

There are too many or too few detected nuclei.
Potential solution

� Adjust the threshold parameter in theMATLAB script. Raise the threshold (more stringent filtering)

to exclude lower correlation peaks and lower the number of cells; lower the threshold (less strin-

gent filtering) to increase the number of detected cells (see step 33 in quantification of labeled

nuclei using MATLAB section).

� Filter the image stacks and template using Gaussian Blur and/or adjust image contrast. The

Gaussian Blur suppresses noise and should reduce spurious peaks. Similarly, flattening the image

background will also suppress noise in the correlation map (see steps 22–23 in image processing

using Fiji/ImageJ section).
Problem 3

Nuclei are detected along edges of the correlation map.
Potential solution

� Increase the padding on the edges of the image stack by increasing the values in the padarray and

in S (dimensions of original image stack plus padding; see step 31 in quantification of labeled

nuclei using MATLAB section):

� stack = padarray(read_file(FileName),[256 256 64]);

� S = [2048 2048 256];
RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources should be directed to and will be fulfilled by the lead

contact, James Jontes (jontes.1@osu.edu).
Materials availability

This study did not generate new unique reagents.
Data and code availability

This study generated new code, which is provided within this manuscript.
SUPPLEMENTAL INFORMATION

Supplemental information can be found online at https://doi.org/10.1016/j.xpro.2023.102596.
ACKNOWLEDGMENTS

This work was supported by the National Institutes of Health (5R01GM141280).
AUTHOR CONTRIBUTIONS

M.R.E. designed and performed research, processed and analyzed data of this project, and wrote

the manuscript. J.D.J. conceived and wrote the MATLAB script, secured funding, and critically

revised the manuscript.
DECLARATION OF INTERESTS

The authors declare no competing interests.
10 STAR Protocols 4, 102596, December 15, 2023

mailto:jontes.1@osu.edu
https://doi.org/10.1016/j.xpro.2023.102596


ll
OPEN ACCESSProtocol
REFERENCES
1. Biswas, S., Emond, M.R., Chenoweth, K.P., and
Jontes, J.D. (2021). d-Protocadherins regulate
neural progenitor cell division by antagonizing
Ryk and Wnt/b-catenin signaling. iScience 24,
102932–102951. https://doi.org/10.1016/j.isci.
2021.102932.
2. Schindelin, J., Arganda-Carreras, I., Frise,
E., Kaynig, V., Longair, M., Pietzsch, T.,
Preibisch, S., Rueden, C., Saalfeld, S.,
Schmid, B., et al. (2012). Fiji: an open-
source platform for biological-image
STA
analysis. Nat. Methods 9, 676–682. https://
doi.org/10.1038/nmeth.2019.

3. Westerfield, M. (1995). The Zebrafish Book
(University of Oregon Press).
R Protocols 4, 102596, December 15, 2023 11

https://doi.org/10.1016/j.isci.2021.102932
https://doi.org/10.1016/j.isci.2021.102932
https://doi.org/10.1038/nmeth.2019
https://doi.org/10.1038/nmeth.2019
http://refhub.elsevier.com/S2666-1667(23)00563-4/sref3
http://refhub.elsevier.com/S2666-1667(23)00563-4/sref3

	XPRO102596_proof_v4i4.pdf
	Quantitation of mitotic cells in the neural tube of zebrafish embryos using automated nuclei counting
	Before you begin
	Institutional permissions

	Key resources table
	Materials and equipment
	2× PBS
	20% Tween 20
	1× PBST
	2% low melting point agarose

	Step-by-step method details
	Fixation of zebrafish embryos
	Permeabilization and immunostaining
	Mounting embryos in agarose and collecting image stacks
	Image processing using Fiji/ImageJ
	Quantification of labeled nuclei using MATLAB

	Expected outcomes
	Limitations
	Troubleshooting
	Problem 1
	Potential solution
	Problem 2
	Potential solution
	Problem 3
	Potential solution

	Resource availability
	Lead contact
	Materials availability
	Data and code availability

	Supplemental information
	Acknowledgments
	Author contributions
	Declaration of interests
	References



